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Introduction to the
Stateflow Product

This chapter describes Stateflow® event-based modeling software and its
components.

“Benefits of Stateflow Usage” on page 1-2

“What Does a Stateflow Chart Look Like?” on page 1-4

“How Stateflow Software Works with Simulink Software” on page 1-6
“Basic Tutorial for Modeling Event-Driven Systems” on page 1-9
“Installing Stateflow Software” on page 1-10

“Related Products” on page 1-13
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Benefits of Stateflow Usage

In this section...

“Models Event-Driven Systems” on page 1-2
“Extends the Capabilities of Traditional State Charts” on page 1-2
“Provides Debugging Capabilities” on page 1-3

“Supports Code Generation in Multiple Languages” on page 1-3

Models Event-Driven Systems

The Stateflow product is an interactive graphical design tool that works with
Simulink® software to model and simulate event-driven systems, also called
reactive systems. Event-driven systems transition from one operating mode to
another in response to events and conditions. These systems are often used to
model logic for dynamically controlling a physical device such as a fan, motor,
or pump. Event-driven systems can be modeled as finite-state machines.

Finite-state machines represent operating modes as states. For example, a

house fan can have states such as High, Medium, Low, and Off. To construct
finite-state machines, Stateflow software provides graphical objects that you
can drag and drop from a design palette to create charts in which a series of
transitions directs a flow of logic from one state to another. You can also add:

® Input and output data

¢ Events for triggering Stateflow charts

¢ Actions and conditions, which you can attach to states and transitions to
further define the behavior of the Stateflow chart

Extends the Capabilities of Traditional State Charts

With traditional state charts, you can specify hierarchy and model parallel
states, among other capabilities. With the Stateflow product, you can extend
the capabilities of traditional state charts by:

¢ Defining functions in the following ways:



Benefits of Stateflow Usage

= Graphically, using flow diagram constructs that model logic patterns
and iterative loops

= Procedurally, using MATLAB® code
= In tabular form, using truth tables
¢ Using directed-event broadcasts to synchronize activity of parallel states
¢ Using temporal logic to schedule events
® Defining vector, matrix, and fixed-point data types
® Modeling continuous or discrete systems

¢ Integrating custom C code that you can call from a chart

Provides Debugging Capabilities

The product provides the following capabilities for testing a design:

* Animation of state charts so that you can watch the logic transition from
state to state or flow from one branch to another during simulation

® A debugger that enables you to set breakpoints and pause simulation at
key points

Supports Code Generation in Multiple Languages

Stateflow software performs simulation by generating a C code
implementation of the Stateflow chart. The simulation code is generated
from a simulation target, which you can learn more about in Chapter 8,
“Simulating the Chart”.

You can also generate portable C code from Stateflow charts automatically
using Simulink® Coder™ code generation software (available separately).
The Simulink Coder product also generates C code for Simulink models that
include Stateflow charts.

In addition to C code generation, you can generate code from Stateflow charts
in the following languages:

e HDL, using Simulink® HDL Coder™ software
e PLC, using Simulink® PLC Coder™ software
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< selection_state

What Does a Stateflow Chart Look Like?

Here 1s an example of a Stateflow chart, which models as a finite-state
machine the logic required to shift gears in an automatic transmission system
of a car:

[ Event

fourth .
entry: gear= 4; State action

during: [down_thup_th] = calc_th{gear throttle];

[speed < down_th] ; Condition
T Transition
[speed < up_th] Parallel
: (AND) state
: Exclusive
after(TWAIT tick) after(TWAIT tick) : (OR) state
[speed == down_th] [speed >= up_th] ;
{gear_state DOWYM) {oear_state UP}

Simulink Function
[down_thup_th] = calc_th(gear throttle)

Notice the following details in this chart:

¢ Each gear and shift position is represented by a state.

* Some states are exclusive (only one can be active at a time) while others
are parallel (can be active concurrently).

¢ Transitions can be triggered by events and conditions.
® States can execute actions while they are active.

* Directed-event broadcasts trigger selective execution of chart logic.



What Does a Stateflow® Chart Look Like?

This chart is part of a model called sf_car that ships with the Stateflow
product. To explore the model further, run it from your MATLAB Command
Window, as described in “Simulink Demo Models” in the Simulink
documentation.

1-5
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How Stateflow Software Works with Simulink Software

Stateflow charts run as blocks in a Simulink model. The Stateflow block
interfaces with other blocks in the model using input and output signals.
Through these connections, Stateflow and Simulink software share data and
respond to events that broadcast between model and chart. For example,
the Stateflow shift logic block is integrated with the Simulink sf_car
model as shown.
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first
entry: gear = 1;

J’{ selection_state
; during: [down_th,up_th] = calc_th{gear throttle);

fourth
entry: gear = 4;

third
entry: gear = 3;

second
entry: gear = 2;

[speed < down_th] ;Speed = up_th]

[speed < up_th]
[speed = down_th]

after(TWAIT tick) after(TWAIT tick)
[speed <= down_th] [speed >= up_th]
{gear_state DO {gear_state UP}

Simulink Function
[down_th,up_th] = calc_th(gear throttle)

sf_car.mdl ™.
- impeller torque
Ne . »lne T| ]
e pthrottle engine RPM
Engine ] gear [
Tout .
MNout o output torque ™
User Inputs - —=
i transmission

transmission speed

=]
Throttle

shift_logic wehicle
speed

. |
=
|
wehicle mph

(yellow)
& throttle %

You can develop your Stateflow chart before or after the Simulink model in
which it will run. Stateflow software comes with its own editor and debugger,
which helps you simulate and test the chart logic before you integrate it with
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a Simulink model. You can test a Stateflow chart independently of its parent
model by attaching a Source block as an input and a Sink block as an output
(see “Sources” and “Sinks” in the online Simulink Reference documentation).
During simulation, you can animate the chart to get visual feedback about
its run-time behavior.
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Basic Tutorial for Modeling Event-Driven Systems

Before you start building a chart, you identify system attributes by answering
these questions:

1 What are your interfaces?
a What are the event triggers to which your system reacts?
b What are the inputs to your system?

¢ What are the outputs from your system?

2 Does your system have any operating modes?
a If the answer is yes, what are the operating modes?

b Between which modes can you transition? Are there any operating
modes that can run in parallel?

If your system has no operating modes, the system is stateless. If your
system has operating modes, the system is modal.

After identifying your system attributes, you can follow a basic workflow for
building Stateflow charts to model event-driven systems:

1 Define the interface to Simulink.

2 Define the states for modeling each mode of operation.
3 Define state actions and variables.

4 Define the transitions between states.

5 Decide how to trigger the chart.

6 Simulate the chart.

7 Debug the chart.

1-9
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Installing Stateflow Software

In this section...

“Installation Instructions” on page 1-10
“Prerequisite Software” on page 1-10
“Product Dependencies” on page 1-11

“Setting Up Your Own Target Compiler” on page 1-11

“Using Stateflow Software on a Laptop Computer” on page 1-12

Installation Instructions

Stateflow software runs on Windows® and UNIX® operating systems. Your
MATLAB installation documentation provides all the information you

need to install Stateflow software. Before installing the product, you must
obtain and activate a license (see instructions in your MATLAB installation
documentation) and install prerequisite software (see “Prerequisite Software”
on page 1-10 for a complete list).

Prerequisite Software

Before installing Stateflow software, you need the following products:

e MATLAB
e Simulink

® C or C++ compiler supported by the MATLAB technical computing
environment

The compiler is required for compiling code generated by Stateflow software
for simulation. The 32-bit Microsoft® Windows version of the Stateflow
product comes with a C compiler (1cc.exe) and a make utility (Lccmake).
Both tools are installed in the folder matlabroot\sys\lcc. If you do not
configure MATLAB to use any other compiler on 32-bit Windows operating
systems, Stateflow software uses 1cc to build targets.

For platforms other than Microsoft Windows or to install a different
compiler, see “Setting Up Your Own Target Compiler” on page 1-11.
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Product Dependencies

For information about product dependencies and requirements, see
www.mathworks.com/products/stateflow/requirements.html

Setting Up Your Own Target Compiler
If you use the UNIX version of the Stateflow product or do not use the lcc

compiler, you must install your own target compiler. You can use any compiler
supported by MATLAB software, as described in “Building MEX-Files” in the
MATLAB External Interfaces documentation.

To install a compiler for the Stateflow product, follow these steps:

1 At the MATLAB prompt, type

mex -setup

2 Follow the prompts for entering information about the compiler.

Tip For a list of supported compilers, see:

www.mathworks.com/support/compilers/current_release/

1-11
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Using Stateflow Software on a Laptop Computer

If you plan to run the Microsoft Windows version of the Stateflow product on
a laptop computer, you should configure the Windows color palette to use
more than 256 colors. Otherwise, you may experience unacceptably slow
performance.

To set the Windows graphics palette:

1 Click the right mouse button on the Windows desktop to display the
desktop menu.

2 Select Properties from the desktop menu to display the Windows Display
Properties dialog box.

3 Select the Settings panel on the Display Properties dialog box.

4 Choose a setting that is more than 256 colors and click OK.

1-12
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Related Products

Several MathWorks® products extend the capabilities of Stateflow
software. For information about these related products, see
www.mathworks.com/products/stateflow/related.htm.
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The Statetlow Chart You
Will Build

To get hands-on experience using Stateflow software, you will build a
Stateflow chart in incremental steps that follow the basic workflow described
in “Basic Tutorial for Modeling Event-Driven Systems” on page 1-9. To give
you a context for your development efforts, this chapter describes the purpose
and function of the chart you will build and explains how it interfaces with a
Simulink model. You will also learn how to run a completed version of the
model from the MATLAB command line.

e “The Stateflow Chart” on page 2-2

e “How the Stateflow Chart Works with the Simulink Model” on page 2-6
* “A Look at the Physical Plant” on page 2-8

¢ “Running the Model” on page 2-11
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The Stateflow Chart

You will build a Stateflow chart that maintains air temperature at 120 degrees
in a physical plant. The Stateflow controller operates two fans. The first fan
turns on if the air temperature rises above 120 degrees and the second fan
provides additional cooling if the air temperature rises above 150 degrees.
When completed, your Stateflow chart should look something like this:

Stateflow (chart) sf_aircontrol/Air Controller EI@

File Edit View Simulation Debug Tools Format  Add  Patterns  Help ke

SEHS ‘@ a4 HE > 0 EHSE BRA0 B

5’|@ |@

YA

BB (= =

4y |31

Ready




The Stateflow® Chart

As you can see from the title bar, the chart is called Air Controller and is part
of a Simulink model called sf_aircontrol. When you build this chart, you
will learn how to work with the following elements of state-transition charts:

Exclusive (OR) states. States that represent mutually exclusive modes
of operation. No two exclusive (OR) states can ever be active or execute at
the same time. Exclusive (OR) states are represented graphically by a solid
rectangle:

The Air Controller chart contains six exclusive (OR) states:

® PoweroOn

® PowerOff

® FAN1.0n

® FAN1.Off

® FAN2.0n

® FAN2.Off

Parallel (AND) states. States that represent independent modes of
operation. Two or more parallel (AND) states at the same hierarchical level
can be active concurrently, although they execute in a serial fashion. Parallel

(AND) states are represented graphically by a dashed rectangle with a
number indicating execution order:

The Air Controller chart contains three parallel (AND) states:

* FAN1
® FAN2

2-3
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® SpeedValue

Transitions. Graphical objects that link one state to another and specify a
direction of flow. Transitions are represented by unidirectional arrows:

The Air Controller chart contains six transitions, from

PoweroOn to PowerOff

* PowerOff to PowerOn

® FAN1.0n to FAN1.0ff

® FAN1.0ff to FAN1.0n

® FAN2.0n to FAN2.0ff

® FAN2.0ff to FAN2.0n

Default transitions. Graphical objects that specify which exclusive (OR)
state is to be active when there is ambiguity between two or more exclusive

(OR) states at the same level in the hierarchy. Default transitions are
represented by arrows with a closed tail:

|

The Air Controller chart contains default transitions:

e At the chart level, the default transition indicates that the state PowerOff
1s activated (wakes up) first when the chart is activated.

® In the FAN1 and FAN2 states, the default transitions specify that the fans be
powered off when the states are activated.

2-4
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State actions. Actions executed based on the status of a state.

The Air Controller chart contains two types of state actions:

® entry (en) action in the PowerOff state. Entry actions are executed when
the state is entered (becomes active).

® during (du) action in the SpeedValue state. During actions are executed for
a state while it 1s active and no valid transition to another state is available.

Other types of state actions

There are other types of state actions besides entry and during, but they
involve concepts that go beyond the scope of this guide. For more information,
see “Using Actions in Stateflow Charts” in the Stateflow User’s Guide.

Conditions. Boolean expressions that allow a transition to occur when the
expression is true. Conditions appear as labels for the transition, enclosed in
square brackets ([ 1).

The Air Controller chart provides conditions on the transitions between
FAN1.0n and FAN1.0ff, and between FAN2.0n and FAN2.0ff, based on the air
temperature of the physical plant at each time step.

Events. Objects that can trigger a variety of activities, including:

e Waking up a Stateflow chart

¢ Causing transitions to occur from one state to another (optionally in
conjunction with a condition)

e Executing actions
The Air Controller chart contains two edge-triggered events:

® CLOCK wakes up the Stateflow chart at each rising or falling edge of a
square wave signal.

® SWITCH allows transitions to occur between PowerOff and PowerOn at each
rising or falling edge of a pulse signal.

2-5
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How the Stateflow Chart Works with the Simulink Model

The Stateflow chart you will build appears as a block named Air Controller
that is connected to the model of a physical plant in the Simulink
sf_aircontrol model. Here is the top-level view of the model:

B sf_aircontrol [E=E Eol =X
File Edit View Simulation Format Tools Help
~ S
O S » = [0 [Nomal ~| EF e [0 & B EE
Group 1 _
SWITCH -
@ CLOCK -
h
Signal Builder 3
temp %ail:kﬁ\' girflow
femp ol L]
160 = smbiznt
Scope
Air Controller Ambient Fhysical Flant
Temperature
Ready 100% oded5

The Simulink model passes the temperature of the plant as an input temp to
the Stateflow Air Controller block. Based on the temperature of the plant, the
controller activates zero, one, or two fans, and passes back to the model an
output value airflow that indicates how fast the air is flowing. The amount
of cooling activity depends on the speed of the fans. As air flows faster, cooling
activity increases. The model uses the value of airflow to simulate the
effect of cooling when it computes the air temperature in the plant over time.
You will learn more about these design elements in Chapter 3, “Defining

the Interface to the Simulink Model”.
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The Signal Builder block in the Simulink model sends a square wave signal
(CLOCK) to wake up the Stateflow chart at regular intervals and a pulse signal
(SWITCH) to cycle the power on and off for the control system modeled by the
Stateflow chart. You will learn more about these design elements in Chapter
7, “Triggering a Stateflow Chart”.
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A Look at the Physical Plant

Simulink software models the plant using a subsystem called Physical Plant,
which contains its own group of Simulink blocks. The subsystem provides a
graphical hierarchy for the blocks that define the behavior of the Simulink
model. The inputs, airflow speed and ambient temperature, model the effects
of the controller activity on plant temperature. Here is a look inside the
Physical Plant subsystem:

(2>

ambient

Ready

W sf_aircontrol/Physical Plant EI@
File Edit View Simulation Format Tools Help
DS HS T b om0 [Noma N EsRe s RBEES
o >
airflow

0

P
L

Constant 008 | > 1
Constant2 %

b4
+

Switch
>
o *
Ll
Product 1
B )
temp
Integrator
: o
T Thermal Isclation
100% oded5

G tant1 e
~ensiEn Multiport

In this model, the internal temperature of the plant attempts to rise to achieve
steady state with the ambient air temperature, set at a constant 160 degrees
(as shown in “How the Stateflow Chart Works with the Simulink Model” on
page 2-6). The rate at which the internal temperature rises depends in part on
the degree of thermal 1solation in the plant and the amount of cooling activity.

Thermal isolation measures how much heat flows into a closed structure,
based on whether the structure is constructed of materials with insulation or



A Look at the Physical Plant

conduction properties. Here, thermal isolation is represented by a Gain block,
labeled Thermal Isolation. The Gain block provides a constant multiplier
that is used in calculating the temperature in the plant over time.

Cooling activity is modeled using a constant multiplier, derived from the
value of airflow, an output from the Stateflow chart. The chart assigns
airflow one of three cooling factors, each a value that serves as an index into
a multiport switch. Using this index, the multiport switch selects a cooling
activity multiplier that is directly proportional to the cooling factor, as follows:

Cooling Factor What It Means Cooling
(Value of Airflow) Activity
0 No fans are running. The value of | 0

temp is not lowered.

1 One fan is running. The value -0.05
of temp is lowered by the cooling
activity multiplier.

2 Two fans are running. The value | -0.1
of temp is lowered by the cooling
activity multiplier.

Over time, the subsystem calculates the cooling effect inside the plant, taking
into account thermal isolation and cooling activity. The cooling effect is the
time-derivative of the temperature and is the input to the Integrator block in
the Physical Plant subsystem. Let the variable temp_change represent the
time derivative of temperature. Note that temp_change can be a warming or
cooling effect, depending on whether it is positive or negative, based on this
equation:

temp_change = ((ambient — temp) * (thermal isolation multiplier)) + ((ambient — temp) * (cooling factor))

2-9
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The Integrator block computes its output temp from the input temp_change,
as follows:

t
temp(t) = J. temp _change(t) dt +70
to

Note In this model, the initial condition of the Integrator block is 70 degrees.

temp is passed back to the Stateflow Air Controller chart to determine how
much cooling is required to maintain the ideal plant temperature.
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Running the Model

To see how the sf_aircontrol model works, you can run a completed, tested
version, which includes the Stateflow chart you will build. Here’s how to do it:

1 Start MATLAB software.

If you need instructions, consult your MATLAB documentation.

2 Type sf_aircontrol at the command line.

This command starts Simulink software and opens the sf_aircontrol

model:
W sf_aircontrol [E=5 Eel =
File Edit View Simulation Format Tools Help
=== 3 |EDD |Nu:un'na| ~| | O e 5] & B EE
Group 1 _
SWITCH -
CLOCK -
¥
Signal Builder E)
temp %air"k:ﬁv sirflow
temp ol L]
1680 J| smbisnt
Scope
Air Controller Ambient Physical Plant
Temperature
Ready 100% oded5

3 Double-click the Air Controller block to open the Stateflow chart.

4 Double-click the Scope block to display the changes in temperature over

time as the model runs.
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Tip Position the Air Controller chart and the Scope window so they are
both visible on your desktop.

5 Start simulation in the Air Controller chart by selecting

Simulation > Start or clicking the Start Simulation icon:

As the simulation runs, the chart becomes active (wakes up) in the
PowerOff state. Notice in the Scope that until PowerOn becomes active, the
temperature rises unchecked. After approximately 350 seconds into the
simulation, a rising edge signal switches power on and the fans become
active.

Note Simulation time can be faster than elapsed time.

When the temperature rises above 120 degrees, FAN1 cycles on. When the
temperature exceeds 150 degrees, FAN2 cycles on to provide additional
cooling. Ultimately, FAN1 succeeds in maintaining the temperature at 120
degrees until a falling edge signal switches power off again at 500 seconds.
Then, the temperature begins to rise again.



Running the Model

The Scope captures the temperature fluctuations:

B cope e e
s5EPeL ARE O a S .

130

o : : I
1 ._I |_| ' B [ DR R TR

110

100 -

100 200 300 400 E00

Stopping or pausing simulation

You can stop or pause simulation at any time. To stop simulation, select
Simulation > Stop or click the Stop Simulation icon:
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To pause simulation, select Simulation > Pause or click the Pause
Simulation icon:

6 Close the model.
Where to go next. Now you are ready to start building the Air Controller

chart. Begin at phase 1 of the workflow: Chapter 3, “Defining the Interface to
the Simulink Model”.
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In phase 1 of this workflow, you define the interface to the Simulink model.
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Implementing the Interface with Simulink

In this section...
“Build It Yourself or Use the Supplied Model” on page 3-2

“Design Considerations for Defining the Interface” on page 3-2
“Adding a Stateflow Block to a Simulink Model” on page 3-3
“Defining the Inputs and Outputs” on page 3-8

“Connecting the Stateflow Block to the Simulink Subsystem” on page 3-16

Build It Yourself or Use the Supplied Model

To implement the interface yourself, work through the exercises in this
section. Otherwise, open the supplied model by entering this command at
the MATLAB prompt:

run(docpath(fullfile(docroot, 'toolbox', 'stateflow','gs', 'examples', 'StageiInterface.mdl')))

Design Considerations for Defining the Interface

The following sections describe the rationale for the input and output of the
Stateflow chart.

Inputs Required from Simulink Model

Type of Input. Temperature of the physical plant

Rationale. The purpose of the chart is to control the air temperature in a
physical plant. The goal is to maintain an ideal temperature of 120 degrees
by activating one or two cooling fans if necessary. The chart must check the

plant temperature over time to determine the amount of cooling required.

Properties of Input. The properties of the temperature input are as follows:

Property Value
Name temp
Scope Input
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Property Value

Size Inherit from Simulink input signal for compatibility
Data type Inherit from Simulink input signal for compatibility
Port 1

Watch in debugger

Enable

Outputs Required from Stateflow Chart

Type of Output. Speed of airflow, based on how many fans are operating

Rationale. When the Simulink subsystem determines the temperature of
the physical plant over time, it needs to account for the speed of the airflow.
Airflow speed is directly related to the amount of cooling activity generated by
the fans. As more fans are activated, cooling activity increases and air flows
faster. To convey this information, the Stateflow chart outputs a value that
indicates whether O, 1, or 2 fans are running. The Simulink subsystem uses
this value as an index into a multiport switch, which outputs a cooling activity
value, as described in “A Look at the Physical Plant” on page 2-8.

Properties of Output. The properties of the airflow output are as follows:

Property Value

Name airflow

Scope Output

Data type 8-bit unsigned integer (uint8)
(The values can be only 0, 1, or 2.)

Port 1

Watch in debugger Enable

Adding a Stateflow Block to a Simulink Model

To begin building your Stateflow chart, you will add a Stateflow block to
a partially built Simulink model called sf_aircontrol_exercise, which
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contains the Physical Plant subsystem, described in “A Look at the Physical
Plant” on page 2-8.

To add a Stateflow block to an existing Simulink model:

1 Open the Simulink model by typing sf_aircontrol_exercise at the
MATLAB command prompt.

The model opens on your desktop:

| =f_aircontrol_exercise E\@
File Edit WView Simulation Format Tools Help
~u LB =
O ESHS P =600 |Nommal | EE RS E
- 1 This is an incomplete model
BUR TR > used in the Stateflow Getting Started Guide
as the foundation model for building
a Stateflow chart and connecting it to Simulink.
P . To see the complete model, type sf_aircontrol
CLOCK - Terminator at the MATLAB command line.
Signal Builder
CI}—} sirflow
inpor - [
180 | ambient Soope
Ambient -
Tempersture Physical Plant
Ready 100% oded5

3-4

The model is incomplete because it does not include the Stateflow chart
that you will build as you work through the exercises in this guide. Instead,
the model contains several nonfunctional blocks: the Terminator, Inport,
and Annotation blocks.

2 Delete the nonfunctional blocks and their connectors.

Tip Hold down the Shift key to select multiple objects, and then press
Delete.
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Your model should now look like this:

=] Stagellnterface ™ E\@
File Edit WView Simulation Format Tools Help
O EES b o= 00 |Nomma sl BB B E
Group 1
SWITCH I
CLOCK -
Signal Builder
airflow
temp - |:I
180 | amnbisnt Scope
Ambient -
Temperature Physical Plant
Ready 100% oded5

3 Save the model as Stagellnterface:
a Create a new local folder for storing your working model.
b In the Simulink model window, select File > Save As.
¢ Navigate to the new folder.
d Enter StageiInterface.mdl as the file name.
e Leave the default type as Simulink Models (¥*.mdl).
f Click Save.

4 On the toolbar of the Simulink model, click the Library Browser icon:

=
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I

The Simulink Library Browser opens on your desktop:

E Sirnulink Library Browser
File Edit Wiew Help

[ @ » Entersearchterm

Libraries

Y

+- W] Simulink Extras

E System Kentification

EEI--E Simulink Control Design -
- §gh| Simulink Design Optimization

- Tgh| Simulink Design Verifier
[

E Simulink Werification and Validation

W= Statefiow L4

Toolbox -

Library: Stateflow | Search Rezults: (none)

o]l =]

Most Freguenthy Used Blocks

Truth Table

Showing: Stateflow

5 Add the Stateflow block to the Simulink model:

a In the left scroll pane of the Library Browser, select Stateflow.

b Drag the first block, called Chart, into your model.
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The model should now look like this:

=] Stagellnterface ™

File Edit WView Simulation Format Tools Help

=N e =

~a Afud h =
D ZES S U ~BEBE Y RE
Group 1
SWITCH
CLOCK -
Signal Builder
airflow
temp |
Chart 180 | amnbisnt Scope
Ambient -
Temperature Physical Plant
Ready 100% oded5

6 Click the label Chart under the Stateflow block and rename it Air

Controller.

Shortcut for adding a Stateflow block to a new Simulink model

At the MATLAB command prompt, enter this command:

stnew
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A new, untitled Simulink model opens on your desktop, automatically
configured with a Stateflow block:

W untitled * E@

File Edit View Simulation Format Tools Help

O =E&E [ 3 |1E'.E' |Nu:un'r|a| j

Chart

Ready 100% oded5

Defining the Inputs and Outputs

Inputs and outputs are data elements in a Stateflow chart that interact with
the parent Simulink model. To define inputs and outputs for your chart,
follow these steps:

1 Double-click the Air Controller block in the Simulink model
StagelInterface to open the Stateflow chart.
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The Stateflow Editor opens on your desktop:

File Edit View Simulation Debug Toecls Format Add Patterns  Help

T

Stateflow (chart) Stagellnterface/Air Controller * EI@

|

BEE ‘@ a4 BHE>» @ v Eelli BRHO =

Yilo’|@ |@

Bl |E = |E

Ei

&b

Ready

2 Add a data element to hold the value of the temperature input from the

Simulink model:

a From the Add menu, select Data > Input from Simulink.
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3-10

The Data properties dialog box opens on your desktop with the General

tab selected:

W Data data ==
General WI
Mame: data
Scope: [Input '] Port: |1
Size: -1 ["] variable size
Complexity: [DFF *]

["] Lock data type setting against changes by the fixed-point tools
Limit range

Minimum: Maximum:

["] watch in debugger

Type: Inherit: Same as Simulink -

[ OK ][ Cancel H Help Apply

The default values in the dialog box depend on the scope — in this
a data input.

b In the Name field, change the name of the data element to temp.

case,
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¢ Leave the following fields at their default values in the General tab
because they meet the design requirements:

Field Default Value What It Means

Scope Input Input from Simulink model. The
data element gets its value from
the Simulink signal on the same
input port.

Size =1 The data element inherits its size
from the Simulink signal on the
same port.

Complexity | Off The data element does not contain
any complex values.

Type Inherit: Same as | The data element inherits its data

Simulink

type from the Simulink signal on
the same output port.

Note Ports are assigned to inputs and outputs in the order they are
created. Because temp is the first input you created, it is assigned to

input port 1.

d In the General tab, select the Watch in debugger check box.

Enabling Watch in debugger lets you examine the value of temp during
breakpoints in simulation. You will try this in Chapter 8, “Simulating

the Chart”.

e Click OK to apply the changes and close the dialog box.

3 Add a data element to hold the value of the airflow output from the Air

Controller chart:

a From the Add menu, select Data > OQutput to Simulink.
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The Data properties dialog box opens on your desktop, this time with
different default values, associated with the scope Output:

W Data data [
General | Description |

Name: data

Scope: [Dutput '] Port: |1

["] Data must resolve to Simulink signal object
Size: [C] variable size

Complexity: [Dﬁ’ ']

Type: double -

[7] Lock data type setting against changes by the fixed-point tools

Initial value: [Expression -
Limit range
Minimum: Maxirmurm:

["] watch in debugger

[ 0K ][ Cancel H Help Apply

Note Because airflow is the first output you created, it is assigned
to output port 1.

b In the Name field of the Data properties dialog box, change the name of
the data element to airflow.
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¢ In the Type field, select uint8 (8-bit unsigned integer) from the submenu.

d Look at the Initial value field.

The initial value is a blank expression, which indicates a default value
of zero, based on the data type. This value is consistent with the model
design, which specifies that no fans are running when the chart wakes
up for the first time.

e Make the following changes for other properties in the General tab:

Property

What to Specify

Limit range

Enter 0 for Minimum and 2 for Maximum.

Watch in
debugger

Select the check box to enable this option.

f Click OK to apply the changes and close the dialog box.

4 Go back to the Simulink model by clicking the up-arrow button in the
Stateflow Editor toolbar:
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Stateflow (chart) Stagellnterface/Air Controller * E@

File Edit View Simulation Debug Toeols Format  Add  Patterns  Help k]l

HE ‘=@ FQ{RQQ}HI@ B ®un0 W

|Up To Stagellnterface/Air Controllerl ]

e

¥ilo e |@

EE|E|E

i 5]

4

Ready
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Notice that the input temp and output airflow have been added to the
Stateflow block:

B Stagellnterface * E\@

File Edit View Simulation Format Tools Help

O =S » E00  |Nomal || O B & B E

]
=
=
5]
T

¥

s}
=]
=}
s}
=
b d

Signal Builder
airflow
temp |
180 J= smbisnt
Ajr Controller v Scope
Ambient -
Tempersture Physical Plant
Ready 100% oded5

Tip You might need to enlarge the Air Controller block to see the input
and output clearly. To change the size of the block:

a Select the block and move your pointer over one of the corners until it
changes to this shape:

"

b Hold down the left mouse button and drag the block to the desired size.

5 Save StagelInterface.
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Tip There are several ways to add data objects to Stateflow charts. You used
the Stateflow Editor, which lets you add data elements to the Stateflow chart
that is open and has focus. However, to add data objects not just to a chart,
but anywhere in the Stateflow design hierarchy, you can use a tool called
the Model Explorer. This tool also lets you view and modify the data objects
you have already added to a chart. For more information, see “Stateflow
Hierarchy of Objects” and “Adding Data Using the Model Explorer” in the
Stateflow User’s Guide. You can also add data objects programmatically
using the Stateflow API, as described in “Creating Stateflow Objects” in the
Stateflow API Guide.

Connecting the Stateflow Block to the Simulink
Subsystem

Now that you have defined the inputs and outputs for the Stateflow Air
Controller block, you need to connect them to the corresponding signals of the
Simulink Physical Plant subsystem. Follow these steps:

1 In the model Stagel1Interface, connect the output airflow from Air
Controller to the corresponding input in Physical Plant:

a Place your pointer over the output port for airflow on the right side
of the Air Controller block.

The pointer changes in shape to crosshairs.

b Hold down the left mouse button and move the pointer to the input port
for airflow on the left side of the Physical Plant block.

¢ Release the mouse.
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The connection should look something like this:

W Stagellnterface *

File Edit View Simulation Format Tools Help

o] -E s

u L .
D EHES b= 0 [Nomal B Re s BE
Group 1
SWITCH -
% CLOCK I
Signal Builder
Firflow
temp pl ]
160 - ambient
Air Controller w Scope
Ambient -
Temperature Physical Plant
Ready 100% oded5

Tip You can use a shortcut for automatically connecting blocks. Select the
source block, and then hold down the Ctrl key and left-click the destination
block.

Connect the output temp from the Physical Plant to the corresponding
input in Air Controller by drawing a branch line from the line that connects
temp to the Scope:

a Place your pointer on the line where you want the branch line to start.

b While holding down the Ctrl key, press and hold down the left mouse
button.

¢ Drag your pointer to the input port for temp on the left side of the Air
Controller block.

d Release the mouse button and the Ctrl key.
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e Reposition the connection so that it looks like this:

=] Stagellnterface ™ E\@

File Edit View Simulation Format Tools Help

~ - .
O = & 3 |EDE' |Norrna| ﬂ i[9 & | = W]
Group 1 _
SWITCH -
E CLOCK -
Signal Builder
airflow
temp ol
180 | ambiznt
Air Controller v Scope
Ambient .
Temperature Physical Plant
Ready 100% oded5

Tip To reposition connections, hold down the left mouse button over any
side of the connection line so that your pointer changes to this symbol:

<

Drag the line to a new location.

3 Save StageilInterface.

Where to go next. Now you are ready to model the operating modes with
states. See “Implementing the States to Represent Operating Modes” on
page 4-2.
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In phase 2 of this workflow, you define the states for modeling each mode
of operation.
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Implementing the States to Represent Operating Modes

In this section...

“Build It Yourself or Use the Supplied Model” on page 4-2
“Design Considerations for Defining the States” on page 4-2
“Adding the Power On and Power Off States” on page 4-7
“Adding and Configuring Parallel States” on page 4-12

“Adding the On and Off States for the Fans” on page 4-19

Build It Yourself or Use the Supplied Model

To implement the states yourself, work through the exercises in this section.
Otherwise, open the supplied model by entering this command at the
MATLAB prompt:

run(docpath(fullfile(docroot, 'toolbox', 'stateflow', 'gs', 'examples', 'Stage2States.mdl')))

Design Considerations for Defining the States

The following sections describe the rationale for the hierarchy and
decomposition of states in the chart.

When to Use States

Whether or not to use states depends on the control logic you want to
implement. You can model two types of control logic: finite state machines
and stateless flow charts. Each type is optimized for different applications, as
follows:
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Control Logic Optimized for Modeling

Finite state Physical systems that transition between a finite

machines number of operating modes. In Stateflow charts, you
represent each mode as a state.

Stateless flow Abstract logic patterns — such as if, if-else, and

charts case statements — and iterative loops — such as

for, while, and do loops. You represent these logic
constructs with connective junctions and transitions
in Stateflow charts. No states are required. See
“Modeling Logic Patterns and Iterative Loops Using
Flow Graphs” in the Stateflow User’s Guide.

The Air Controller chart is a system that cools a physical plant by
transitioning between several modes of operation and, therefore, can be
modeled as a finite state machine. In the following sections, you will design
the states that model each mode of operation.

Determining the States to Define

States model modes of operation in a physical system. To determine the
number and type of states required for your Air Controller chart, you must
identify each mode in which the system can operate. Often, a table or grid
is helpful for analyzing each mode and determining dependencies between
modes.

Analysis of Operating Modes. For Air Controller, the modes of operation

are
Operating Description Dependencies
Mode
Power Off Turns off all power in | No fan can operate when power
the control system is off.
Power On Turns on all power in | Zero, one, or two fans can
the control system operate when power is on.
Fan 1 Activates Fan 1 Fan 1 can be active at the same
time as Fan 2. When activated,
Fan 1 can turn on or off.
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Operating Description Dependencies

Mode

Fan 1 On Cycles on Fan 1 Fan 1 On can be active if Fan 1
is active and power is on.

Fan 1 Off Cycles off Fan 1 Fan 1 Off can be active if Fan 1
is active, and power is on.

Fan 2 Activates Fan 2 Fan 2 can be active at the same
time as Fan 1. When activated,
Fan 2 can turn on or off.

Fan 2 On Cycles on Fan 2 Fan 2 On can be active if Fan 2
is active and power is on.

Fan 2 Off Cycles off Fan 2 Fan 2 Off can be active if Fan 2
is active and power 1s on.

Calculate Calculates a constant | Calculates the constant value,

airflow value of 0, 1, or 2 to based on how many fans have

indicate how fast air
is flowing. Outputs
this value to the
Simulink subsystem
for selecting a cooling
factor.

cycled on at each time step.

Number of States to Define. The number of states depends on the number
of operating modes to be represented. In “Analysis of Operating Modes” on
page 4-3, you learned that the Air Controller chart has nine operating modes.
Therefore, you need to define nine states to model each mode. Here are the
names you will assign to the states that represent each operating mode in
“Implementing the States to Represent Operating Modes” on page 4-2:

State Name Operating Mode
PowerOff Power Off
PoweroOn Power On

FAN1 Fan 1

FAN2 Fan 2
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State Name Operating Mode
SpeedValue Calculate airflow
FAN1.0n Fan 1 On
FAN1.Off Fan 1 Off
FAN2.0n Fan 2 On
FAN2.Off Fan 2 Off

Note Notice the use of dot notation to refer to the On and Off states for FAN1
and FAN2. You use namespace dot notation to give objects unique identifiers
when they have the same name in different parts of the chart hierarchy.

Determining the Hierarchy of States

Stateflow objects can exist in a hierarchy. For example, states can contain
other states — referred to as substates — and, in turn, can be contained

by other states — referred to as superstates. You need to determine the
hierarchical structure of states you will define for the Air Controller chart.
Often, dependencies among states imply a hierarchical relationship — such
as parent to child — between the states.

Based on the dependencies described in “Analysis of Operating Modes” on
page 4-3, here is an analysis of state hierarchy for the Air Controller chart:

Dependent States Implied Hierarchy

FAN1 and FAN2 depend on PoweroOn. FAN1 and FAN2 should be substates
No fan can operate unless PoweroOn of a PowerOn state.
1s active.

FAN1.0n and FAN1.0ff depend on FAN1 should have two substates,
Fan1 and PowerOn. FAN1 must be On and Off. In this hierarchical

active before it can be cycled on or relationship, On and Off will inherit
off. from FAN1 the dependency on
PoweroOn.
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Dependent States

Implied Hierarchy

FAN2.0n and FAN2.0ff depend on
FAN2 and PowerOn. FAN2 must be

active before it can be cycled on or
off.

FAN2 should have two substates,

On and Off. In this hierarchical
relationship, On and Off will inherit
from FAN2 the dependency on
Poweron.

The state that calculates airflow
needs to know how many fans are
running at each time step.

The state that calculates airflow

should be a substate of PoweroOn so
it can check the status of FAN1 and
FAN2 at the same level of hierarchy.

Determining the Decomposition of States

The decomposition of a state dictates whether its substates execute exclusively
of each other — as exclusive (OR) states — or can be activated at the same
time — as parallel (AND) states. No two exclusive (OR) states can ever be
active at the same time, while any number of parallel (AND) states can be

activated concurrently.
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The Air Controller chart requires both types of states. Here is a breakdown of
the exclusive (OR) and parallel (AND) states required for the Stateflow chart:

State Decomposition | Rationale

PowerOff, Exclusive (OR) The power can never be on and off at
PowerOn states the same time.

FAN1, FAN2 Parallel (AND) | Zero, one, or two fans can operate at

states the same time, depending on how much
cooling is required.

FAN1.0n, Exclusive (OR) Fan 1 can never be on and off at the
FAN1.Off states same time.

FAN2.0n, Exclusive (OR) Fan 2 can never be on and off at the
FAN2.0ff states same time.

SpeedValue Parallel (AND) SpeedValue is an observer state that

state

monitors the status of Fan 1 and Fan
2, updating its output based on how
many fans are operating at each time
step. SpeedValue must be activated at
the same time as Fan 1 and Fan 2, but
execute last so it can capture the most
current status of the fans.

Adding the Power On and Power Off States

When you add states to the Air Controller chart, you will work from the
top down in the Stateflow hierarchy. As you learned in “Determining the
Decomposition of States” on page 4-6, the PowerOff and PowerOn states are

exclusive (OR) states that turn power off and on in the control system. These
states are never active at the same time. By default, states are exclusive (OR)

states, represented graphically as rectangles with solid borders.

To add PowerOn and PowerOff to your chart, follow these steps:

1 Open the model StagelInterface — either the one you created in the
previous exercise or the supplied model for stage 1.
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To open the supplied model, enter the following command at the MATLAB
prompt:

run(docpath(fullfile(docroot, 'toolbox', 'stateflow', 'gs"', 'examples', 'StagetInterface.mdl')))

2 Save the model as Stage2States in your local work folder.

3 In Stage2States, double-click the Air Controller block to open the
Stateflow chart.
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The Stateflow Editor for Air Controller opens on your desktop. Notice the
object palette on the left side of the editor window. This palette displays a
set of tools for drawing graphical chart objects, including states:

State toolicon

Stateflowy (chart) Stage2States/Air Controller * EI@

File Edit] View Simulation Debug Tools Format Add Patterns  Help N

sHSE it R4 HEr 1 0 s EBRAO | =

! A

5’|@ |®

1?1- ;&

slElS]E

]

&b

[ I

Ready

4 Left-click the state tool icon:

5 Move your pointer into the drawing area.
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The pointer changes to a rectangle, the graphical representation of a state.
6 Click in the upper-left corner of the drawing area to place the state.
The new state appears with a blinking text cursor in its upper-left corner.

7 At the text cursor, type PowerOn to name the state.

Tip If you click away from the text cursor before typing the new name, the
cursor changes to a question mark. Click the question mark to restore
the text cursor.

8 Move your pointer to the lower-right corner of the rectangle so it changes
to this symbol:

"
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9 Drag the lower-right corner to enlarge the state as shown:

Stateflow (chart) Stage2States/Air Controller *
File Edit

EE @

View Simulation Debug Tools

=i | HE

e

[E=% o ==
Format Add  Patterns  Help k]l
b s el BEAO W

ﬁower@n

¥ilo e |@

BB (= E

E
= \ /
100%
7
I
Ready
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10 Click the state tool icon again and draw a smaller state named PowerOff at
the bottom of the drawing area, like this:

Stateflow (chart) Stage2States/Air Controller * E@

File Edit View Simulation Debug Toeols Format  Add  Patterns  Help k]l

EHSES ‘B les 4| BE )y 1 8 EasH EBRMAO B

ﬁower@n \ =

o’|® |[B

vA

BB (= E

dip =
/
\

PowerQOff

I ]

Ready

11 Save the chart by selecting File > Save Model in the Stateflow Editor, but
leave the chart open for the next exercise.

Adding and Configuring Parallel States

In “Determining the States to Define” on page 4-3, you learned that FAN1,
FAN2, and SpeedValue will be represented by parallel (AND) substates of the
PoweroOn state. Parallel states appear graphically as rectangles with dashed
borders.
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In this set of exercises, you will learn how to:
e Assign parallel decomposition to PowerOn so its substates can be activated
concurrently.

Recall that the decomposition of a state determines whether its substates
will be exclusive or parallel.

® Add parallel substates to a state in the chart.
® Set the order of execution for the parallel substates.

Even though parallel states can be activated concurrently, they execute
in a sequential order.

Setting Parallel Decomposition
Follow these steps:

1 In the Air Controller chart, right-click inside PoweroOn.

A submenu opens, presenting tasks you can perform and properties you
can set for the selected state.

2 In the submenu, select Decomposition > Parallel (AND).

3 Save the model Stage2States, but leave the chart open for the next
exercise.

Adding the Fan States
Follow these steps:

1 Left-click the state tool icon in the Stateflow Editor and place two states
inside the PoweroOn state.

Tip Instead of using the state tool icon to add multiple states, you can
right-click inside an existing state and drag a copy to a new position in the
chart. This shortcut is convenient when you need to create states of the
same size and shape, such as the fan states.
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2 Notice the appearance of the states you just added.

The borders of the two states appear as dashed lines, indicating that
they are parallel states. Note also that the substates display numbers in
their upper-right corners. These numbers specify the order of execution.
Although multiple parallel (AND) states in the same chart are activated
concurrently, the chart must determine when to execute each one during
simulation.

3 Name the new substates FAN1 and FAN2.
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You have created hierarchy in the Air Controller chart. PowerOn is now a
superstate while FAN1 and FAN2 are substates. Your chart should look
something like this:

Stateflow (chart) Stage2States/Air Controller * E@

File Edit View Simulation Debug Toeols Format  Add  Patterns  Help k]l

EHSES ‘B les 4| BE )y 1 8 EasH EBRMAO B

ﬁower@n \ =

PowerQOff

Ready

Note Your chart might not show the same execution order for parallel
substates FAN1 and FAN2. The reason is that, by default, Stateflow software
orders parallel states based on order of creation. If you add FAN2 before
FAN1 in your chart, FAN2 moves to the top of the order. You will fine-tune
order of activation in a later exercise, “Setting Explicit Ordering of Parallel
States” on page 4-17.
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Tip If you want to move a state together with its substates — and any
other graphical objects it contains — double-click the state. It turns gray,
indicating that the state is grouped with the objects inside it and that they
can be moved as a unit. To ungroup the objects, double-click the state again.

4 Save the model Stage2States, but leave the chart open for the next
exercise.

Adding the SpeedValue State

Recall that SpeedValue acts as an observer state, which monitors the status
of the FAN1 and FAN2 states. To add the SpeedValue state, follow these steps:

1 Add another substate to PowerOn under FAN1 and FAN2, either by using the
state tool icon or copying an existing state in the chart.

You might need to resize the substate to prevent overlap with other
substates, but remain within the borders of PoweroOn.
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2 Name the state SpeedValue.

Like FAN1 and FAN2, SpeedValue appears as a parallel substate because its
parent, the superstate PowerOn, has parallel decomposition.
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3 Save the model Stage2States, but leave the chart open for the next
exercise, “Setting Explicit Ordering of Parallel States” on page 4-17.

Setting Explicit Ordering of Parallel States

Recall that, by default, Stateflow software assigns execution order of parallel
states based on order of creation in the chart. This behavior is called explicit
ordering. In this exercise, you will set the execution order explicitly for each

parallel state in your chart.
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1 In the Stateflow Editor, select File > Chart Properties.

2 In the Chart properties dialog box, verify that the check box User
specified state/transition execution order is selected and click OK.

E Chart: &ir Contraller @
Mame:  Air Controller i

Maching: (maching) Stage2States

State Machine Type: |Classic -

Update method: |Inherited > | Sarnple Time:

Enable C-bit operations

¥ User specified state/transition execution order
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Export Chart Level Graphical Functions (Make Global)
¥ Use Strong Data Typing with Simulink /0

Execute (enter) Chart At Initialization
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Support variable-size arrays
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Note This option also lets you explicitly specify the order in which
transitions execute when there is a choice of transitions to take from one
state to another. This behavior does not apply to the Air Controller chart
because it 1s deterministic: for each exclusive (OR) state, there is one and
only one transition to a next exclusive (OR) state. You will learn more
about transitions in “Drawing the Transitions Between States” on page 6-4.

3 Assign order of execution for each parallel state in the Air Controller chart:

a Right-click inside each parallel state to bring up its state properties

submenu.

b From the submenu, select Execution Order and make these

assignments:
For State: Assign:
FAN1 1
FAN2 2
SpeedValue 3

Here is the rationale for this order of execution:

® FAN1 should execute first because it cycles on at a lower temperature

than FAN2.

® SpeedValue should execute last so it can observe the most current

status of FAN1 and FAN2.

4 Save the model Stage2States, but leave the chart open for the next
exercise, “Adding the On and Off States for the Fans” on page 4-19.

Adding the On and Off States for the Fans

In this exercise, you will enter the on and off substates for each fan.
Because fans cannot cycle on and off at the same time, these states must be
exclusive, not parallel. Even though FAN1 and FAN2 are parallel states, their
decomposition is exclusive (OR) by default. As a result, any substate that 